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Preface

These guidelines are intended to assist California Energy Commission contract, grant, or work
authorization managers and contractors when preparing a Public Interest Energy Research
(PIER) Program project report that is the result of technical research funded via a contract,
grant, or work authorization.

Be sure to check these guidelines and talk with your Energy Commission contract, grant, or work
authorization project manager before starting any PIER Program technical research project
report. If your contract, grant, or work authorization is for technical research that results in an
interim or final report, please follow this manual.

Although this manual is formatted in PIER styles, not all of its elements replicate those of a
PIER report. The most recent version of this manual and the templates that can be used to
develop PIER reports are located at:

Your project’s contract, grant, or work authorization Terms and Conditions may provide
additional information about producing PIER Program project reports or other printed
materials.

If you are not sure these guidelines apply to your report, or if you have any questions about the
information in the guidelines, please contact your Energy Commission contract, grant, or work
authorization manager, or e-mail Energy Commission staff at *

Contact information for the main PIER offices is available under the Energy Research &
Development Division listing at ﬁ

Please cite this report as follows:

Aldrich, Bob, Mark Wilson, Sunni Chacon, Susanne Garfield-Jones, Carol Robinson, Adam
Gottlieb, Deborah Dunster, and Holly Larsen. 2006. Style Manual: Preparing Public Interest
Energy Research (PIER) Program Technical Research Project Reports. California Energy Commission,
PIER Program. CEC-500-2006-006.
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Abstract

This report is the manual of style to be used when writing reports funded by the California
Energy Commission’s Public Interest Energy Research (PIER) Program. This document helps
PIER Program project teams write interim and final project reports that meet the Energy
Commission’s requirements for technical research report content, style, and format. This
document will be published online with links from the PIER and Contracts Office Web pages.
Microsoft® Word files for the PIER styles template, cover, and credits pages can be
downloaded from those Web pages as well.

This document may be revised as the Enerey Commission deems necessary. Please check for the

Keywords: Public Interest Energy Research (PIER) Program, writing, style manual, technical
project report, project report, interim project report, final project report, publication process,
report preparation, report format



Please note that this page is normally left blank and is the back side of the abstract and
keywords page. Usually no information is included on this page, nor is there text that says “this
page left intentionally blank.” This blank page must be included for the report to print two-sided

pages properly.

Vi



1.0 Roles and Responsibilities for Preparing PIER Project
Reports

CURRENTLY UNDER DEVELOPMENT



Please note that this page is normally left blank and is the back side of the final odd page of
Chapter 1. It is inserted so Chapter 2 will begin on an odd-numbered page. Usually no
information is included on this page, nor is there text that says “this page left intentionally blank.”
This blank page must be included for the report to print two-sided pages properly.



2.0 Publication Steps for PIER Project Reports

CURRENTLY UNDER DEVELOPMENT



Please note that this page is normally left blank and is the back side of the final odd page of
Chapter 2. It is inserted so Chapter 3 will begin on an odd-numbered page. Usually no
information is included on this page, nor is there text that says “this page left intentionally blank.”
This blank page must be included for the report to print two-sided pages properly.



3.0

Preparing Accurate, Consistent PIER Project Reports

Before you begin writing, put on the hat of an inquisitive, reasonably well-educated lay reader.
Pretend that they paid for this research and want to understand how and why you spent their
money. That’s your audience. Even though research colleagues may be the only people who read
your report, you need to make the writing clear and understandable to a larger audience. Your
reader may not speak or read English as a first language. So, you must write clearly and
concisely.

Here are some suggestions to keep in mind as you write the report:

Apply the test of completeness. Are all the pieces there? Are all the references clear and
do those in the text match those in the reference section? Are the relationships between
the partners and the players clearly explained?

Apply the test of logic. Does the document flow and make sense? Is the need for the
research clearly described? Is the technical approach clearly described? Do the
conclusions make sense? Are they drawn from the analysis? Do the numbers check? Is it
clear how the numbers were derived?

If the project did not do everything it intended to do, explain.

The final report must primarily address the project scope (that is, the funded,
contracted research agreement scope of work). Where appropriate, clearly differentiate
the overall or larger program scope from the funded, contracted research agreement
scope of work and explain the context. Do not intermingle comments about the larger
program with comments about the funded, technical research contract, grant, or work
authorization research project.

There needs to be a clear relationship between project objectives and outcomes.
The methods used to conduct the research need to be explained.

Data that are presented in the report need to be analyzed. If you present a picture,
graph, or table, be sure you discuss it in the text. Do not just refer to it. Also, provide
the graphic’s data source file when submitting your report to the Energy
Commission. Remember, not everyone wants to or can print in color, so it is best if your
graphic can also be copied in black and white. Apply the “would this be clear if it were
faxed?” test.

Each conclusion needs to be substantiated by the analysis contained in the report.

Figures and tables must clearly relate to and be consistent with the text, and vice versa.
(If the text says the generator had a capacity of 30 kilowatts, the table should not say it
was 31.2 kilowatts.)

Use consistent references to report performance specifications and results. For example,
if a piece of equipment is to be referred to by its nominal nameplate rating, then use that
reference consistently throughout the report. If, however, the desired number was the
measured performance of the device (almost always different from nameplate), then
consistently use that measured number. Do not mix the two in the narrative.



* The text needs to clearly refer to the attached appendices. It should also explain how
the material in the appendices relates to the text. If the information does not really
matter, the appendix probably should be dropped. (You may still need it because it is a
deliverable according to the contract agreement, so check this carefully.) References to
multi-page appendices need to be specific to the page or section of the appendix, not
just a general reference to “Appendix B.” Appendices carry their own page numbering;
see Chapter 6 for instructions.

If you have a question about what the report should include, contact your Energy Commission
contract, grant, or work authorization manager to discuss the report. Make sure you understand
all the required parts.



4.0 Editorial Style for PIER Project Reports

General rules for good writing should be applied to all reports and other written materials
funded by the PIER Program. The following books are recommended to assist authors in
developing good writing habits:

Associated Press, The. The Associated Press Stylebook and Libel Manual. Perseus Books, 2006.
ISBN: 0201339854.

Cappon, Rene]. (Editor). The Associated Press Guide to Punctuation. Perseus Publishing, 2003.
ISBN: 0738207853.

Fiske, Robert Hartwell. The Dictionary of Concise Writing: 10,000 Alternatives to Wordy
Phrases. Marion Street Press, 2002. ISBN: 0966517660.

Sabin, William A. The Gregg Reference Manual (10th Edition). McGraw-Hill Irwin, 2005.
ISBN: 0072936533.

Strunk, William, Jr., E. B. White, and Roger Angell. The Elements of Style, Fourth Edition.
Longman, 2000. ISBN: 020530902X.

Style Manual Committee, Council of Science Editors. Scientific Style and Format: The CSE
Manual for Authors, Editors, and Publishers (7th Edition). University of Cambridge,
2006. ISBN: 097796650X.

University of Chicago Press. The Chicago Manual of Style (15th Edition). University of
Chicago Press, 2003. ISBN: 0226104036.

These books may disagree on points of editorial style. Choose one book and stick with that as

your guide.

Acronyms and Abbreviations

An acronym is an abbreviation made up of the initial letters of a group of words and is
pronounced as a single word. For example, HVAC (heating, ventilation, and air conditioning) is
pronounced H-VAC. Abbreviations are the initial letters of a group of words but cannot be
pronounced as a single word. The Energy Commission uses these two terms interchangeably,
most often including abbreviations under the umbrella of acronyms.

Use acronyms sparingly when using terms over and over.

This does not mean, however, that acronyms should be made up as a form of shorthand. This
style of writing excludes the reader by introducing words that are only known to a “select few.”

An acronym should benefit the reader; not cause them to stop reading and start hunting for the
first time the acronym was used.

Acronyms will be allowed at the discretion of the Energy Commission’s editors.
Follow these rules when using acronyms or abbreviations.

* Do not make up acronyms as shorthand for a group of words.
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Introduce acronyms by first using the full term, followed by the acronym in parentheses.

Energy Commission style does not allow the use of most acronyms in the Abstract and
Executive Summary because these elements are often read by a broader audience that
may be less familiar with the subject matter. The list below in Table 1 shows a number
of common acronyms that may be used in the Abstract and Executive Summary after
first spelling out the full word(s).

Do not use the abbreviation “CEC” in reports or in other written materials, except if
used in a table heading where space is critical.

Use “California Energy Commission” at first mention, and then use "Energy
Commission" throughout the rest of the report.

You may use just “Commission” in subsequent references in the same paragraph as long
as no other commissions are being mentioned. Return to using the full two words Energy
Commission in subsequent paragraphs.

Do not introduce and use an acronym if it only appears once or twice in close proximity.
Rare exceptions would be cases where readers are more familiar with the acronym than
its actual referent.

Do not use the U.S. Postal Service two-letter abbreviations for states in the United
States. Instead, use the full state name (for example, Sacramento, California) or the
“longer” abbreviation (such as Los Angeles, Calif.).



Table 1: Common Acronyms and Abbreviations

Original Term

Acronym/Abbreviation

California Energy Commission

Energy Commission

British thermal unit Btu

California Air Resources Board ARB (not CARB)

California Department of Water Resources DWR

California Environmental Protection Agency CalEPA

California Independent System Operator California ISO (not CAISO or Cal-ISO)
(California) Public Utilities Commission CPUC

carbon dioxide

CO; or CO2 (Note: The 2 can be a subscript, but make sure it

is not too small to read.)

cubic feet per minute CFM

(United States) Department of Energy U.S. DOE

Energy Action Plan Energy Action Plan (not EAP)
Energy Efficiency Ratio, Seasonal Energy Efficiency Ratio EER, SEER

ENERGY STAR®

ENERGY STAR® on first reference, followed by ENERGY
STAR thereafter

Federal Energy Regulatory Commission FERC

gigawatt / gigawatt-hour GW / GWh

Heating, ventilation, and air conditioning HVAC

Integrated Energy Policy Report IEPR

kilovolt kV

kilowatt / kilowatt-hours kW (small k, capital W) / kWh
liquefied natural gas, liquefied petroleum gas LNG, LPG

Los Angeles Department of Water and Power LADWP

MCF

Use MCF on first reference, but in parentheses say (1000
cubic feet of natural gas).

megawatt / megawatt-hour

MW (all capitals) / MWh

Nitrogen Oxides NOXx or NOy
Nuclear Regulatory Commission NRC
Organization of Petroleum Exporting Countries OPEC
Pacific Gas and Electric Company PG&E
photovoltaic PV

Public Interest Energy Research Program PIER Program
quadrillion British thermal units quad
research, development, and demonstration RD&D
Sacramento Municipal Utility District SMUD

San Diego Gas & Electric Company SDG&E
Note: The word “and” is not used in the company’s full name. An

ampersand [ & ] is the correct usage in the company’s full name.

Southern California Edison Company SCE
Southern California Gas Company SoCal Gas
sulfur dioxide SOx

United States

United States (not U.S. unless it proceeds an abbreviation for

a federal agency)

United States Environmental Protection Agency

U.S. EPA (not EPA)

M&PCO / Revised 6.28.07




Capitalization
Do NOT capitalize:

* Use “state” unless the text specifically says “the State of California.”
* Use “energy crisis,” not Energy Crisis.

+ Use “project” or “program” unless it is an official part of a name or title, such as the
Sunrise Transmission Project or PIER Program.

»  Use “website,” not Website or Web site.
Capitalize:
* Governor, Legislature, Senate, and Assembly (when pertaining to California).

*  Northern California, Southern California.
e ZIP code.

Citations Within the Text

PIER reports use the author-date system of citation in the text, as follows: (Author 2004). There
is no comma between the author’s name and the date. For multiple citations, please use the
following style: (Brown 2004; Goodwin and Hersch 2002; Alert et al. 2000; Kumis 2004a,
2004b). The full citation should be included in the report’s references.

Internet and E-mail Addresses

Microsoft Word can be configured to automatically create hotlinks to Internet addresses (URLs)
and a mail-to link for e-mail address. Creating the hotlink changes the text to blue and
underlines the text. When a reader clicks on the link, the text color changes to purple. When the
Word file is converted to Adobe® Acrobat®, Acrobat usually incorporates the hotlinks. Please
make sure the URLs are correct.

If possible, avoid splitting Internet addresses across two lines.

Miscellaneous
* Use only one space between sentences and after a colon.
*  Use “smart” (also called curly or typographic) quotes and apostrophes.

* Use an en dash (-) between a range of numbers. From the Insert menu, select Symbol >
Special Characters = en dash.

¢ Use an em dash (—) instead of a double hyphen (--). Do not add a space before or after
the em dash.

» Use italics, not quotation marks, to introduce new technical terms. Include such terms in
the glossary if appropriate.

» Every graph and table requires a source line beneath it, unless the data were obtained by
the author(s) during the course of the project. In any event, the data source should
always be clear.

10



*  Write out “percent” in the executive summary. Use the symbol “%”in the main body of
the report.

* TItalicize the name of all books and reports. For example: 2005 Integrated Energy Policy
Report and 2004 Energy Policy Report Update. Do not underline. If the information cited
is from a journal, the article title should be in quotation marks and the journal name in
italics.

» Use brackets for parenthetical material within parentheses ([ ]).

Numbers

* Inalist in linear text, use numbering (in parentheses) to indicate the order in which tasks
should be done, to suggest chronology or relative importance among the items, or to
clearly separate the items, as in the following examples:

When repairing the machine, the researchers (1) gathered the parts, (2) assembled the
subsystems, (3) connected the subsystems, and (4) conducted tests to establish
baseline performance.

When evaluating the policy, researchers considered (1) wind turbines, both old and
new; (2) energy conservation programs that encourage consumers to reap the benefits
of off-peak electricity; and (3) photovoltaic installations—including emerging
technologies that use thin-film materials—in regions with superior insolation.

Otherwise, do not use numbering, as in the following example:
There are three key drivers of natural gas prices: supply, demand, and storage
capacity.
+ Always use commas in numbers that are five digits or larger: 12,400; 240,000. Commas
can be inserted in four-digit numbers when they are used in tables or columns.
* Use numerals for 10 and above; spell out numbers under 10, EXCEPT:
Percentages (2 percent).
Dates (June 2, 2005).
Page numbers (page 6).
Chapter numbers (Chapter 4).

Energy increments (1 megawatt, 9 kilowatts).

© O o o o o

Sentences that include a list of identical items, some of which are fewer than 10 and
some are more: “The project ran 2 trials in April, 5 in May, and 14 in June.”

o Table and figure numbers (Table 4, Figure 6).

* Never begin a sentence with a numeral, including a year. “The energy crisis began in
2000,” NOT “2000 marked the year the energy crisis began.”

*  Use the metric system (International System of Units, or SI) or English units—whichever
is most appropriate to the report. When referring to temperatures, however, use Celsius
along with Fahrenheit following in parentheses. For example: 100°C (212°F). Note that
there should not be a space between the temperature, the degree symbol, and the letter.
For executive summaries, use both SI and English units of measurement to support a

11



greater understanding by a lay audience. Use of standard English measures (e.g., acre-
foot, two-by-fours) is always appropriate.

Punctuation

Serial Comma
Use a serial comma style throughout the report. For example: “The research team tested the
first, second, and third models.” The comma after “second” is the serial comma.

In a serial list, if an element of the list has multiple units that need to be separated with
commas, use a semicolon instead of a comma between the main elements, as in the first example
under Bulleted Lists, below.
Bulleted Lists
Consider using a bulleted list for complicated sentences like the following example:

This report provides policy recommendations to conserve resources; protect the

environment, the economy, and public health and safety; and ensure reliable, secure, and
diverse energy supplies.

The above is correct, but it is clearer if bullets are used:
This report provides policy recommendations to:

* Conserve resources.
» Protect the environment, the economy, and public health and safety.
* Ensure reliable, secure, and diverse energy supplies.
In bulleted lists, use “parallel construction” for the items in your list. For example, if one item

starts with a verb, all items should start with a verb; if one item begins with a noun, all items
should begin with a noun, and so forth.

Use the following guides for punctuating bulleted lists:

+ Start each bulleted element with a capital letter.

+ Inmost cases, place a period at the end of each listed element. Thus, use a period after
any “long” element in the list—independent clauses, dependent clauses, or long phrases.
Also use periods after short phrases that are essential to the grammatical completeness
of the statement introducing the list. However, no periods are needed after short phrases
that are grammatically independent of the introductory statement, or if the listed items
are like those on an inventory sheet or a shopping list.

12



Commas with Dates

Do not put a comma between a month and a year (July 2006), but do put a comma between a
day and a year and after the year if in a sentence. For example: The Declaration of
Independence was signed on July 4, 1776, in Philadelphia, Pennsylvania.

Compound Adjectives

Many compound adjectives are hyphenated when they come before a noun: “investor-owned
utilities.” They are not hyphenated when they come after the verb: “The utilities are investor
owned.”

Do not hyphenate compound adjectives starting with “—ly” adverbs: “publicly owned,” NOT
“publicly-owned”; “newly created,” NOT “newly-created.” But hyphenate compound

", ou

adjectives with adverbs that do not end in “ly”: “well-designed equipment.”

Special Characters and Symbols

Microsoft Word has a listing of special characters that can be used when typing. To view the
special characters, go to Insert > Symbol. These special characters make use of the “Symbol”
typeface that comes with and is installed by Microsoft Word. These special characters are the
same across computer platforms. For symbols that are not in a standard typeface or font
family, please contact the PIER contract manager to discuss using them in a report.

Writing Style
*  Use the active voice whenever possible: “The petroleum industry is building new storage
facilities,” NOT “New storage facilities are being built by the petroleum industry.”

* The Energy Commission does not allow use of the first person (referring to the authors)
in technical reports. This is not to say that you should write in the passive voice—it is
possible to write in the third person and still use active voice. For example:

Instead of third person passive voice: “It was found by the research team that...”

Use third person active voice: “The research team found that...” or “The study
found that...” or “Results showed that...”

Writing in the third person requires that the authors refer to themselves as though they
were referring to a third party:

First person: “We tested 12 different devices...”

Third person: “The authors (or “The research team” or “This project” or some
other similar third-party reference) tested 12 different devices...”

+ Eliminate excess words. For example: “To calculate the emissions...” NOT “In order to
calculate the emissions...”

» Avoid verbal nouns. For example: “The team analyzed...” NOT “The team conducted
an analysis of...”

13



Please note that this page is normally left blank and is the back side of the final odd page of
Chapter 4. It is inserted so Chapter 5 will begin on an odd-numbered page. Usually no
information is included on this page, nor is there text that says “this page left intentionally blank.”
This blank page must be included for the report to print two-sided pages properly.
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5.0

Content for PIER Project Reports

Report Sections

PIER project reports contain the following sections, in the following order:

1.
2.

Cover page (required).

Credits page (required) with Legal Disclaimer (required). The Energy Commission
disclaimer is ALWAYS included. Disclaimers from other agencies or organizations are

optional and should be placed on the otherwise blank page following the credits page
(the back side of the credits page when printing double sided).

Acknowledgments page (acknowledgments are optional; the mandatory citation
typically appears here).

Citation (required). Normally, the citation appears at the bottom of the
acknowledgments page. If there are no acknowledgments, the citation appears at the
bottom of the preface or the “back side” of the credits page (see instructions later in this
chapter).

Preface (required boilerplate).

Table of Contents (required, followed by List of Figures and List of Tables, if needed).
Abstract, including Keywords (required).

Executive Summary (required).

Introduction (required).

. Project Approach [or Methods] (required for final reports).

. Project Outcomes [or Results] (required for final reports).

. Conclusions and Recommendations (required for final reports).
. References (if applicable).

. Glossary (if more than 10 acronyms are used, this is required).
. Bibliography (if applicable).

. Appendices (if applicable).

. Attachments (if applicable).

Except in very short reports (20 pages or less), each section must start on a new right-hand,
odd-numbered page. Even in short reports, “front matter” sections and the executive summary
should always start on a new page. If the preceding section ends on an odd-numbered page,
insert a blank page to make the next section begin on the right-hand, odd-numbered page.

To view an example of a properly formatted PIER report, please see:

15



PIER Project Cover Page, Credits Page, and Disclaimers

PIER cover and credit pages use PIER templates, which are available from the Energy
Commission’s website at NCHOEVCAOVIICONIACISI PISTECONIABIONS! Complete the
information as fully as you can. You will be asked to provide the following information on those

pages:
Cover Page
+ Title of the report
+ Type of report (e.g., interim or final)
* Author’s company, organization, or affiliation
* Logo of author’s company, organization, or affiliation, if desired

The Energy Commission will insert the publication number and month of publication, unless
previous arrangements have been made.

Please contact the PIER _ for additional cover page guidance if the

research is being done by a collaborative that may have multiple sponsors.

Credits Page (Note: The credits page was previously called the “title” page)
» PIER logo (PIER will provide this)
* Author’s company, organization, or affiliation
* Name of primary author(s) or principal investigator(s)
* Location of author’s company, organization, or affiliation (city, state, and ZIP code)

* PIER Agreement number (contract, grant, work authorization, and /or project number[s],
as applicable)

* PIER program area

* Name of PIER contract, grant, or work authorization manager
» Name of PIER project manager (if different)

+ Name of PIER program area lead (PIER can fill this in)

* Name of PIER office manager (PIER can fill this in)

The Energy Commission disclaimer is provided on the PIER credits page template.

The credits page should be only one page long. If more space is required, then please contact
your PIER contract, or grant, or work authorization manager or the Technology Transfer Office.
Additional Legal Disclaimers

The California Energy Commission’s legal disclaimer is provided on the PIER credits page
template. If any other participating organization needs a legal notice on the document, please
provide it on the page following the credits page (i.e., the back of the credits page when printing
double sided).

Acknowledgments and Citation Page

This page comes before the preface and table of contents and is where page numbering begins
with lowercase roman numerals (i).
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Acknowledgments

This section acknowledges or expresses appreciation to those who participated in the project. It
may be a paragraph or a bulleted list of names and, if appropriate, their affiliations.

Acknowledgments are optional. If acknowledgments are not included, do not create an
acknowledgments page simply for the citation. Instead, put the citation at the bottom of the
preface page. If there is no room at the bottom of the preface, then list the citation at the bottom
of the blank page following the credits page (back side of credits when printing double sided).

Citation
It is mandatory to include a citation for your report in the following style:
* Author last name, Author first name (or initial).
Note: If there are multiple authors, list with chief researcher’s name first, or list
alphabetically. First name in the series should have the last name followed by first name;

then followed by second first name, second last name, and so forth. Use commas
between authors’ names.

* Year of publication.

* Report title in italics.

+ California Energy Commission, PIER [insert RD&D program area] Program.

* Energy Commission publication number. Format for publication number is CEC-500-

YEAR-XXX. Note: If not assigned, the Energy Commission will fill in the Xs.

Typically, the citation is located at the bottom of the acknowledgments page. As stated, if there
are no acknowledgments, the citation should go at the bottom of the preface page, or if there is
no room there, place it at the bottom of the blank (“back side”) page following the credits page.

Citation Examples

Please cite this report as follows:

Wolman, H., and R. E. Moon (Engineering International). 2006. Widgets and More. California
Energy Commission, PIER Energy-Related Environmental Research Program. CEC-500-2006-
XXX. (That is, Woolman and Moon work for Engineering International, so this optional method
of listing authors incorporates both the authors and the company they work for.)

Additional examples:

San Francisco Public Utilities Commission. 2006. Hetch Hetchy Case Study. California Energy
Commission, PIER Renewable Energy Technologies Program. CEC-500-2006-002.

Boles, Steve, Steve Folking, Pamela Green, Changsheng Li, and William P. Salas. 2006.
Estimating Irrigation Water Use for California Agriculture: 1950s to Present. California Energy
Commission, PIER Energy-Related Environmental Research Program. CEC-500-2006-057.
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Preface

Use the following preface verbatim. It is available on the PIER contracts page at:

In the next-to-last paragraph, fill in the report title; type of report; contract, grant, or work
authorization name and number; organization conducting the research; and PIER program area
(one of the eight research areas in the bulleted list).

Preface

The Public Interest Energy Research (PIER) Program supports public interest energy research
and development that will help improve the quality of life in California by bringing
environmentally safe, affordable, and reliable energy services and products to the marketplace.

The PIER Program, managed by the California Energy Commission (Energy Commission),
conducts public interest research, development, and demonstration (RD&D) projects to benefit
California.

The PIER program strives to conduct the most promising public interest energy research by
partnering with RD&D entities, including individuals, businesses, utilities, and public or private
research institutions.

PIER funding efforts are focused on the following RD&D program areas:

* Buildings End-Use Energy Efficiency

* Energy Innovations Small Grants

* Energy-Related Environmental Research

* Energy Systems Integration

* Environmentally Preferred Advanced Generation

* Industrial / Agricultural/ Water End-Use Energy Efficiency

* Renewable Energy Technologies

* Transportation
[Report title in italics] is the [final or interim—select one] report for the [project name] project
(contract number XXX-XX-XXX, work authorization number [insert #] or grant number [insert

#]) conducted by [research entity]. The information from this project contributes to PIER’s
[insert RD&D program area from bulleted list above] Program.

For more information about the PIER Program, please visit the Energy Commission’s website at

_ or contact the Energy Commission at 916-654-5164.
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Table of Contents
Sections to be included in the table of contents are listed below. Titles for the Project Approach,
Project Outcomes, and Conclusions and Recommendations chapters may vary—the other
section titles are mandatory. Chapter numbers may also change depending on the report.
» Preface (required)
* Abstract and Keywords (required)
+ Executive Summary (required)
* Chapter 1. Introduction
* Chapter 2. Project Approach [or Methods]
» Chapter 3. Project Outcomes [or Results]
* Chapter 4. Conclusions and Recommendations
o Conclusions (required)
o Commercialization Potential (if applicable)
o Recommendations (required)
o Benefits to California (required)
» Chapter 5. References (if applicable)
* Chapter 6. Glossary (if applicable)
* Chapter 7. Bibliography (if applicable)
* Appendices (if applicable) (Enter appendix titles in the table of contents manually)
» Attachments (if applicable) (Enter attachment titles in the table of contents manually)

Generate the table of contents using Microsoft Word’s automated feature. To do so, go to Insert
- Reference = Index and Tables = Table of Contents 2 OK. Add at least two levels of heads
(or more) under the table of contents to help the reader know the contents of the chapters.

For the preface and abstract, it may be necessary to enter a few periods before the page number
so that the dot leader works properly. Note that appendix and attachment listings must be
entered by hand. Do not provide page numbers for appendices or attachments.

Following the table of contents, generate the list of figures and the list of tables, if needed, using
Word’s automated features. To do so, go to Insert > Reference > Index and Tables > Table of
Figures. Under “Caption Label” choose either Figure or Table, then in Options, Style, choose
“Figure caption” (for a figure) or “Table caption” (for a table) > OK.

Update the table of contents, list of figures, and list of tables after all editing has been
completed, and proofread to ensure that the entries are complete and correct. (Microsoft’s
automatic table of contents feature, while very useful, is not perfect and can occasionally mis-
create entries.)
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Abstract

All Energy Commission reports are required to have a short abstract. This concise, informative
summary of the report is geared toward a more technical audience and should be less than 200
words—about a half page, single spaced. (You can use “Word Count” in the “Tools” menu of
Microsoft Word to check the number of words.)

The abstract should address the report’s purpose, scope, methods, and major findings,
including the report’s results, conclusions, and recommendations. Abstracting services publish
abstracts to help readers determine whether a report is targeted to their area of interest;
therefore, it should be understandable as a stand-alone document. The abstract should not
contain undefined symbols, abbreviations, or acronyms, and should not refer to specific
numbered elements of the main report. It should not refer to other research literature unless it is
essential to clarify the document’s purpose. If the report is a supporting document to another
report, that information should be noted. Do not, however, include citations in the abstract.

The abstract must contain 5-20 keywords that will help search engines and other databases
track the report’s subject matter. The keywords should be listed separately four lines below the
abstract. Separate each word by commas with no ending punctuation. For example:

Keywords: Solar, photovoltaic, PV cells, PV panels, building-integrated PV, BIPV,
electricity production, distributed generation

Executive Summary
The executive summary is a final report in miniature, containing all the key information. It
summarizes the report and should include the following headings:

* Introduction

*  Purpose (outlining the broad purpose)

* Project Objectives (those that are measurable and foreseeable)

* Project Outcomes (this section may be missing from an interim report)

+ Conclusions (this section may be missing from an interim report)

*  Recommendations (this section may be missing from an interim report)

* Benefits to California
These headings will not appear in the table of contents. They do not take a numbered heading.

The executive summary is intended to be short (preferred length is 2-3 pages). It can use a
succinct, bulleted format to summarize the pertinent points under each of these sections, or can
be more conversational (but still succinct). Assume a non-technical, management-level
readership. If your report covers more than one project, repeat this organization for each project
area.

As a report summary, the executive summary should not present new information that is not
found in the main document, and the executive summary should not repeat the abstract.

Do not cite references in the executive summary.
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The executive summary marks the division between front matter, with lowercase roman numeral
pagination, and the body of the report. Thus, the first page of the executive summary will
always be page 1 (arabic) of the report.

Introduction

The introduction summarizes the purpose of the project and puts the need for the research into
context. The following outline is a suggestion, but not mandatory.

Background and Overview—Provide relevant background. Define (at an intelligent lay person’s
level) the problem being addressed by the project. Identify the project’s subject area and
research goals. Refer to the contract for this information.

Project Objectives—Present the technical and economic objectives for your project. The
objectives need to express how to measure or know whether or not the objectives have been
achieved. This information should be taken from the contract and should reflect any changes
made during the course of the project. (Describe why these changes were made in the project
approach section.)

Each objective shall be separately identified. A useful form is to use an action verb followed by
relevant text, for example:

Project objectives were to:

* Verify...
e Determine...
¢ Measure...

Report Organization—Very long or complicated reports may benefit from a paragraph
outlining the report’s organization. For most reports, this is not necessary.

Project Approach (or Methods)

This section discusses the tasks you undertook and what you did to accomplish your
objectives. Discuss the testing procedures you undertook and any system modifications and
improvements you made.

Note that the Energy Commission does not permit the use of first person in PIER reports.
Thus, instead of “We tested X” you must write “The research team tested X” or “The project
tested X.”

Project Outcomes (or Results)

This section presents your results. Please organize them in the same order as the objectives. An
easily readable style is to state a brief version of each outcome in bulleted form and then follow
each bullet with supporting paragraphs that describe each outcome, although any well-
organized presentation will be accepted.

There can be more outcomes than there were objectives, because there may be more than one
outcome per objective, or you may have found an unanticipated outcome during your research.
However, you cannot have stranded objectives; all objectives, whether met or not, must be
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discussed in this section. If this section is particularly long, you may wish to summarize the
outcomes at the end of the section.

Conclusions and Recommendations

Conclusions—Conclusions must be drawn from evidence presented in the report, and there
must be a conclusion for every objective presented earlier. Present your conclusions either in
priority order or in the same order as the objectives presented earlier. You may have conclusions
that are broader than individual objectives and outcomes. If so, please present these separately
from the individual conclusions.

Commercialization Potential—If your project had a task to prepare a Production Readiness
Plan or a similar effort to assess where the research stands in relationship to being used in its
relevant markets, please discuss that task in this section.

Recommendations—Specific recommendations for future research should derive from the
conclusions presented and should be presented in the same priority order as those conclusions.
Specific recommendations could broadly describe the research initiative(s), provide a
rationale, and include an estimate of the funding level required; it is acceptable to provide an
estimate as a range (low to high dollar amount). Also, include an estimate of the time required
to carry out the recommended next steps. For example, would this be a multi-year study
requiring three to five years, or would this be a scoping study that could be completed in a
year? Please be succinct. General recommendations should follow. Please do not add specifics
on the time and cost of follow-on activities in the executive summary.

Benefits to California—Discuss these two issues in this section:

* The benefits that California has already received from this contract (if applicable).

* How California will or could benefit from the results of this project. These benefits need
to be related to the problems that this research was intended to address; however,
discussion of ancillary benefits is also encouraged. Refer to the executive summary
section of the report—the list of benefits in both sections should be identical.

References

The references must list all documents cited in the body of the report. List references in a
standard alphabetical format. Use PIER’s Normal font (Palatino Linotype, 11 point). Please
check that all of the references contained in the body of the report are accurate and that the full
citation for each reference is listed in the references section.
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For formatting of references, consult the following books:

Sabin, William A. The Gregg Reference Manual (10th Edition). McGraw-Hill Irwin, 2005. ISBN:
0072936533.

Style Manual Committee, Council of Science Editors. Scientific Style and Format: The CSE
Manual for Authors, Editors, and Publishers (7th Edition). University of Cambridge, 2006.
ISBN: 097796650X.

University of Chicago Press. The Chicago Manual of Style (15th Edition). University of
Chicago Press, 2003. ISBN: 0226104036.

Any documents referred to in the appendices should be listed in a reference section in that
appendix; that is, each appendix carries its own references section.

Glossary

If the report uses more than 10 acronyms, please provide a glossary with definitions for each
acronym. Use Microsoft Word’s table feature to create a two-column format.

Bibliography

A bibliography includes references that were used in preparation of the report, but are not cited
in the report. This section is optional. If used, consult the same reference books mentioned in the
references section, above, for formatting guidance.

Appendices

An appendix is supplementary material that is produced by the report’s author(s).

The body of the report needs to refer clearly to the attached appendices. References to multi-
page appendices need to be specific to the specific page or section of the appendix, not just a
general reference to “Appendix D.” The report should also explain how the material in the
appendices matters to the text. If it does not really matter, the appendix probably should be
dropped. (You may still need it because it is a deliverable according to your contract, grant, or
work authorization agreement, so check this carefully.)

Designate appendices by capital letters (Appendix A, Appendix B, Appendix C, etc.), not
numbers.

If a document’s file size with appendices is large (more than 5.0 megabytes), the appendices are
published by the Energy Commission as separate documents from the main report. All
appendices must be either part of the main document or presented as separate PDF files.
Appendices that are separate volumes are given their own publication numbers, covers, and
credits pages. See Chapter 6 for more details.

If the appendix has been previously published by another organization or agency with a
different cover, it receives a PIER cover page but no credits page.

Further, if the appendix has been previously published by another organization or agency, you
must provide written permission from the original publisher for the Energy Commission to post
the material on the Energy Commission website indefinitely. See Chapter 6 for details.
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Attachments

An attachment is supplementary material produced by someone other than the report’s
author(s). To attach this material, you must provide written permission from the original
publisher for the Energy Commission to post the material on the Energy Commission website
indefinitely.

If attachments are required, they are designated by roman numerals (e.g., Attachment I,
Attachment II). See Chapter 6 for more details.
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6.0 Formatting PIER Project Reports

Format Styles

Contractors must use the PIER project report typographic styles described in these guidelines.
They are summarized in Chapter 7, Formatting Style Matrix for PIER Project Reports. These
styles—and boilerplate cover and credits pages—are provided on the Energy Commission’s
website:

1 Main PIER Report Styles
1 PIER Cover Page Template
1 PIER Credits Page Template

You can also access these items from the main PIER contractors information page at:

To use the PIER styles template, simply copy it as a .doc file and insert your report document
at the end (and delete the template text). If that doesn’t work, try the following procedure:

1. Download the Style Template from the link above.

2. Open the template.

3. Save it as a template (.dot) document.

4

Copy the entire report at the end of the template (where the 0 PIER Normal font
paragraph mark appears on the second page of the template file).

5. Delete the template text.

As you format your report, be sure to apply the exact “0 PIER” styles listed in the template. For
example, 0 PIER Normal is not the same as Normal.

Blank Pages

Blank pages should be inserted after the cover page, the credits page, and before each section if
necessary for the new section to start on the right-hand side of the report when bound as a
book. The one exception is when there is no acknowledgments page; in that case, if the citation
will not fit on the preface page, the citation should be inserted at the bottom of the otherwise
blank page following the credits page. Number all blank pages from the acknowledgments page
onward.

Pagination
Use Palatino Linotype 10 pt. for page numbers, centered at the bottom of each page.

Pagination begins on the acknowledgments and citation page (as i, ii, iii...) and continues in
lowercase roman numerals through the preface, table of contents, and the abstract. The cover
and credits pages are not numbered. Number the blank pages but do not put “This Page
Intentionally Left Blank” on blank pages.
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On the first page of the executive summary, begin numbering “1” and continue sequential
numbering throughout the document. See the Appendices and Attachments discussion for page
numbering of those sections.

Page Breaks

If a subheading is at the bottom of the page, but the text jumps to the next page, put a page
break before the subheading. Font metrics may be slightly different depending on the computer
operating system. Including a page break will ensure that headings are not left alone at the
bottom of a page with no content.

Figures and Tables

Figures and tables can use any style that presents the information clearly and is readable.
Chapter 7 provides guidance for the typography of table cells and column heads.

Captions must use the 0 PIER styles specified in the formatting matrix in Chapter 7. Note that
captions should be separate from the figure or table itself, not embedded in the graphic file.

The list of figures and list of tables should be automatically generated in a manner similar to the
table of contents. If figure or table captions are particularly long, hand-edit them in the list of
figures/list of tables as you see fit.

Remember to submit original graphics files with your report.

Footnhotes

Only footnotes (not endnotes) should be used in PIER project reports. They should be used
sparingly to briefly clarify terms or concepts that may not be understood by the average reader.
Footnotes are placed at the bottom of the page on which they appear.' Do not place footnotes
at the end of a section. Insert footnotes using Microsoft Word’s footnote feature: Insert 2>
Reference - Footnote.” Footnote numbering should automatically readjust as footnotes are
added or deleted.’ Footnotes should be entered after periods or commas.

1. The footnote number appears in the text as a superscript. The associated footnote appears below in
the footnote section at the bottom of the page.

2. Microsoft Word will automatically superscript the footnote number at the bottom of the page.
Because this is so small, please unsuperscript it—that is, apply the 0 PIER Footnote Text style to the
number, as shown in these examples. Add a period after the number.

Use 0 PIER Footnote Text style for the footnote itself. Do not add an extra space between footnotes; the
spacing is built into the style.

3. Reviewers using Microsoft’s Track Changes feature will observe that footnote numbering may remain
out of sequence until all tracked changes have been accepted.
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Table of Contents

The table of contents should be generated automatically using Microsoft Word’s Insert -
Reference > Index and Tables feature. (Any appendices or attachments must be added
manually.) The table of contents is based on the style headings assigned to each section. The
table of contents should be checked to make sure it has been updated correctly after each series
of edits. Checking that chapters and headings agree with the page numbering should be the last
task before creating the Adobe Acrobat PDEF.

Appendices and Attachments

An appendix is supplementary material that is produced by the report’s author(s). An
attachment is supplementary material that is produced by someone other than the author(s).

Copyright and Permissions

If the document has been previously published, the researcher/contractor must obtain written
permission from the copyright holder before it can be republished by the Energy Commission.
You should ask for “written permission for electronic publishing of the document in Adobe
Acrobat PDF format on the California Energy Commission’s website.” Make sure there is no
time limit on the permission—that is, ensure that the file may be posted on the Energy
Commission’s website indefinitely.

Send a photocopy of the written permission to your PIER contract, grant, or work authorization
manager when you deliver the report and the appendix(es) or attachment(s).

All previously published documents will be posted as separate files, with their own cover
pages. No credits page is needed for appendices or attachments not funded by PIER. On the
cover page where the words “Prepared By” are located, please include the following statement
verbatim:

This document is an attachment to a report funded by the California Energy
Commission’s Public Interest Energy Research (PIER) Program. The PIER Program did
not fund this document, but the author(s) of the PIER-funded report has/have attached
it as a supporting document.

The California Energy Commission wishes to thank the copyright holder, [fill in name of
author and/or publisher or whoever holds copyright], for permission to republish this
document in electronic format on the Energy Commission’s website.

Please contact this document’s author/ publisher for additional information about the
document.
Appearance in Table of Contents
When preparing the table of contents for the report, you need to manually enter each appendix
letter and title (or attachment number and title) into the table of contents. Do not enter the
appendix/attachment page numbers.
Preparing Appendices

Appendices should use the same Energy Commission-required format and style as the main
report. If an appendix was previously published using a different style and format, that
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organization’s or agency’s style and format does not necessarily need to be changed.
Appendices are sometimes edited or reformatted by the Energy Commission, but not always, so
ensure that the material is accurate and clear.

Appendices are typically included at the end of the main report. However, they are posted as
separate documents if (1) their inclusion in the final report creates a file that is larger than five
megabytes or (2) the work was not funded by PIER and thus requires copyright permission for
publication. Short appendices may be combined into one volume.

Appendices as Part of the Main Report

The first page of each appendix should be a title page, containing the following information:

* Appendix A (or B or C, etc.), assigned a 0 PIER Centered Title style.
+ Title of appendix, assigned a 0 PIER Centered Title style.
* APA-1 (or APB-1, APC-1, etc.), page numbering centered on the bottom of the page.

This title page should be followed by a blank, unnumbered page (which forms the back side of
the title page when printing double sided). The content of the appendix will thus begin on a
right-hand page. Paginate the content of the appendix with arabic numerals (1, 2, 3, etc.).

Appendices as Documents Separate from the Main Report

Where the appendix would normally go in the main report, insert a “slip sheet” that lists the
following information:

* Appendix A (or B or C, etc.), assigned a 0 PIER Centered Title style.
+ Title of appendix, assigned a 0 PIER Centered Title style.

» Text on the slip sheet saying: “This appendix is available in a separate volume, CEC-
500-YEAR-XXX-APX.” That is, provide the publication number of the appendix on the
slip sheet (see discussion of publication numbers, below).

The slip sheet has no page number.

If there is more than one appendix, the titles of each appendix may be listed on a single slip
sheet. The title of the page, in that case, should be “Appendices” (0 PIER Centered Title) with
the appendix letters and titles, and their publication number(s), neatly arranged as a list.

If you have multiple small appendices, they may be combined into a single volume if the file size
permits. If the multiple appendices create a file larger than five megabytes, then separate
volumes should be created for each appendix. Appendices are posted online in Adobe Acrobat
PDF format.

Each separate appendix file must have its own PIER cover page and publication number. If the
work was funded by PIER, each separate appendix must also have a PIER credits page. The
publication number for each appendix is provided by the Energy Commission. The number
consists of the report’s publication number (CEC-500-YEAR-XXX) plus the suffix -APA, -APB,
-APC, etc., depending on the letter of the appendix. Therefore, the publication number for
Appendix B of a report could read like: CEC-500-2006-972-APB.
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If the work in the appendix was not funded by PIER, be sure the cover page contains the
boilerplate copyright permission language provided earlier in this chapter under Copyrights and
Permissions.

Preparing Attachments
Attachments are designated with roman numerals rather than letters (Attachment I,
Attachment II, etc.).

Attachments are published separately from the main report. Prepare a single slip sheet and
cover page(s) the same way as for appendices. The Energy Commission will assign a
publication number to each attachment.

In most cases, attachments will require permission to publish from the copyright holder. It is the
report author’s responsibility to obtain this permission; be sure to include the boilerplate
permission language on the cover page.
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Please note that this page is normally left blank and is the back side of the final odd page of
Chapter 6. It is inserted so Chapter 7 will begin on an odd-numbered page. Usually no
information is included on this page, nor is there text that says “this page left intentionally blank.”
This blank page must be included for the report to print two-sided pages properly.
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7.0 Formatting Style Matrix for PIER Project Reports

Applies To Style Name Style Definition

Normal 0 PIER PIER standard is Palatino Linotype 11 pt., align left, line
Normal spacing at least 14 pt., 0 pt. before paragraph, 8 pt. after

Al regglar text that. 'S paragraph. Palatino Linotype is used because of its readability
not assigned a special wU? i €
height and “m” width.

, due to its larger “x
style (e.g., heading,
bullet, caption) Palatino Linotype (11 pt.)
The quick, fast fox jumped over the lazy brown dog.

If Palatino Linotype is not available, please use the same line
spacing with one of the following typefaces:

Century Schoolbook (11 pt.)
The quick, fast fox jumped over the lazy brown dog.

Times New Roman (use 12 pt.)
The quick, fast fox jumped over the lazy brown dog.

Text is align left (ragged right), not fully justified.

No paragraph indentation.

Appendix Text 0 PIER Uses same styles and formatting as main report.
Normal
Attachments PIER does not edit attachments or require its formatting to be
used.
Bullets 0 PIER Bullet | Palatino Linotype, 11 pt., O pt. before and 4 pt. after item, at

least 14 pt. line spacing.

Bullet should be indented 0.25" from left. Text should have a
hanging indent of 0.25" (so it is set at 0.5" from the left).
* Bullet item number 1.
* Bullet item number 2.
o Bulletitem number a.
o Bulletitem number b.
* Bullet item number 3.

Second-level bullets are indented 0.5" with a hanging indent
of 0.25".
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Applies To Style Name Style Definition

Bullets, cont. 1. As shown here, if items are numbered, apply the “0
PIER Bullet” style first, then click on the numbered list
button on the formatting menu bar, which will change
the bullets to numbers.

The list may be followed by a return, placing space between it
and following text (use your judgment as to what looks best
for a given list).

Captions for Figures 0 PIER Arial, 10 pt., bold, 3 pt. before and after.
(Graphs, Charts, Figure . . )

. . Brief captions are preferred; however, some graphics may
Drawings, Caption ) lenathi i " I
Photographs) require a lengthier caption. If so, you may use a smaller

caption font (8—10 pt.) at your discretion. Typically, captions
should not introduce new information.

Captions for photographs should include an 8 pt. photo credit
with the individual's or company’s name.

Figures can be numbered in chapter-number format (e.g.,
Figure 2-1, Figure 2-2, etc.) or numbered sequentially through
the entire report (e.g., Figure 1, Figure 2, etc.). Use the same
numbering style for any tables.

Figures are labeled:
Figure #. Title of figure in sentence case (there is no period at
the end of the caption unless it is a complete sentence)

The figure itself should be centered on the page. Align the
caption under the left edge of the figure, as shown:

Figure 3-1. Building-integrated solar roofing used in
a solar car port. UNI-SOLAR metal roofing in the

project is by Solar Utility of Culver City, California.
Photo Credit: United Solar Systems Corporation




Applies To Style Name Style Definition

Captions for Tables 0 PIER Table | Arial, 10 pt., bold, 3 pt. before and after.
Caption . . .
Center the table; align caption with left edge of table.

Tables are labeled:

Table #. Title of table in sentence case (there is no period at
the end of the caption unless it is a complete sentence)

Tables can be numbered in a chapter-number format (e.g.,
Table 2-1, Table 2-2, etc.) or numbered sequentially through
the entire report (e.g., Table 1, Table 2, etc.). Use the same
style for numbering figures.

Avoid the use of text boxes wherever possible and insert the
tables directly into the document.

Every table presented must be referred to in the text.

Equations Equations are centered on a new line.

Avoid the use of Microsoft Word text boxes wherever possible
and insert the equations directly into the document.

Every equation presented must be referred to in the text.

If special characters are used to create the equation, make
sure typefaces are supported and available across various
computer operating systems or platforms.

Occasionally, special characters may not be available in a
standard typeface. It would be better to create the equation as
a graphic in TIF or JPG format and insert it into the text as a

graphic file.
Figures Figures should be centered. Align captions with left edge of
(Graphs, Charts, figure.
Drawings, ) .
Avoid the use of Word text boxes wherever possible and
Photographs) ) i . .
insert the figures directly into the document.
Every figure presented must be referred to in the text.
If the figure is a graphic, picture or photograph, it should be at
least 300 dots per inch (dpi). Do not use low-resolution
Internet pictures (72 to 96 dpi).
Footnotes 0 PIER Footnote style is Palatino Linotype, 10 pt., O pt. before and 6

Footnote Text | pt. after. The footnote reference number should be superscript
in the text but not in the footnote itself.
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Applies To Style Name Style Definition

Graphs It is not necessary to title a graph while it is being created in
the graph-creating software (such as Microsoft Excel)
because the graph title is supplied by the caption.

Please label all axes.
Use sentence case.

Include units.

Glossary Please use table format with word or acronym on the left side
and the definition on the right side. Do not show gridlines. Do
not use tabs or spaces to “create” the table, but use the table
function in Microsoft Word.

Both columns are align left; column width is flexible depending
on the width of the largest word.

Chapter Headings 1.0 0 PIER PIER style is Arial, bold, 16 pt.
(Level 1) Head 1

Left aligned, O pt. before, 6 after.
Headings are in title case.

Headings are outline numbered, with tab stop 0.5".

Head shows as 1.0, without a final period, in contrast to lower-
level heads which use a final period; this is an artifact of
Microsoft Word.

If the first element of the chapter is a sub-head (level 2 head),
do not use a carriage return before the sub-head. If the first
element of the chapter is regular text, use a carriage return (0
PIER Normal) between the chapter head and the first
paragraph.

Sub-Headings 1.1. 0 PIER PIER style is Arial, bold, 14 pt.
(Level 2) Head 2 )
Left aligned, 12 pt. before, 3 after.

Headings are in title case.

Headings are outline numbered, tab stop 0.5".

Head shows as 1.1.

There is no additional carriage return before the next
paragraph or heading.
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Applies To Style Name Style Definition

Sub-Sub-Headings 1.1.1. PIER style is Arial, bold italic, 12 pt.
(Level 3) 0 PIER

Head 3 Left aligned, 6 pt. before, 3 after.

Headings are in title case.
Headings are outline numbered, tab stop 0.5".
Head shows as 1.1.1.

There is no additional carriage return before the next
paragraph or heading.

Sub-Sub-Sub- 0 PIER PIER style is Arial, bold italic, 11 pt.
Headings (Level 4) Head 4 .
Left aligned, 6 pt. before, 3 after.
Headings are in title case.

There is no outline number for Level 4 heads.

There is no additional carriage return before the next
paragraph or heading.

Page Numbers Begin numbering “i” on the acknowledgments/citation page.

On the first page of the executive summary, begin numbering
“1”.

Use Palatino Linotype, 10 pt.
Centered, bottom.

See the appendix and attachments sections of this document
for pagination of those sections.

References Use 0 PIER Normal style but with a 0.5" hanging indent.

Table Column 0 PIER Table | Arial, bold, 9 to 10 pt.
Headings Heading . L )
First column heading is align left; all other column headings
are centered.

Row headings are align top.

Use sentence case.

Table Data Cells 0 PIER Table | Arial, 8 to 10 pt. depending on amount of text. Be consistent
Cell throughout entire table.

35



Applies To Style Name Style Definition

Table of Contents 0 PIER Chapter number is aligned at left margin with hanging indent
Normal for of 0.5".
text;
0 PIER Preferably, section numbers are tabbed at 0.5" from the line
Centered above with hanging indent at 0.5".
Title for title Page numbers are set with tab right at 6.5", with a dot leader.
Page numbers are all aligned right.
Titles: Centered Title 0 PIER Arial, 14 pt., bold, 0 pt. before, 20 after.
Headings Centered ,
Title Centered, title case.
This style applies to title headings not a part of the body of the
paper (Acknowledgments, Table of Contents, List of Figures,
and List of Tables). These heads do not show in the table of
contents.
There is no additional carriage return before the next
paragraph or heading.
Titles: Centered TOC 0 PIER Arial, 14 pt., bold, 0 pt. before, 20 after.
Headings Centered ,
TOC Centered, title case.

This style applies to title headings (such as Preface, Abstract,
and Executive Summary) that do show in the table of
contents.

There is no additional carriage return before the next
paragraph or heading.
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8.0 Submitting Reports to the Energy Commission

Most companies use the Microsoft Office suite of software programs for word processing,
spreadsheets, and presentations. The Energy Commission requests that report files be
compatible with Microsoft products. This request, however, does not mean that the Energy
Commission or the State of California endorse these products. Other word processing software
programs may be used as long as the saved files are compatible with Microsoft Word XP
(2002).

Please provide the contract, grant, or work authorization name and number in the e-mail subject
line, if sending the report by e-mail attachment. When submitting reports to the Energy
Commission, please send all files relating to the document, including original figure files. That
way, the Energy Commission will be able to replicate the document in the future or convert it
into future publication formats as technology changes.

Microsoft Word Files

Send copies of the cover page, credits page, and full documents as Microsoft Word .doc files.
These may be combined into one file or sent as separate files. Appendices should be sent as
.doc files as well.

When saving the file, please make sure that the copy has all tracked changes accepted into the
final version, unless it is undergoing further editing. Do not password protect or encrypt the
documents or files.

The properties of the file should be filled out. Go to File - Properties menu and complete the
information in the Summary portion. These include:

e Title
* Subject
e Author

* Manager

*  Company

+ Category (optional)
*  Keywords

* Comments (optional)

Graphic Files and Photographs

Contractors need to send a copy of all of the graphic files in the report with the final document
file. These files should be sent to the PIER contract, grant, or work authorization manager and
eventually to the Energy Commission’s Webmaster on a CD or DVD. Embed the graphic in the
report document, but also save each file separately from the main report. Save pictures/photos
in either Photoshop PSD (please include layers if used), TIF, or JPG format.
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Graphics and photographs should be saved at a higher resolution, at least 300 dots per inch
(dpi). Do not use lower-resolution (72 or 96 dpi) graphics that are found on websites, as they
do not reproduce well in printed documents.

Label graphic files names so they correspond with their figure title in the report. For example, if
you have a photograph used as Figure 23, label the file name as figure_23.jpg.

Use underscores ( _ ) between words in file names instead of spaces. Do not use the following
charactersin a filename: ' @ # $ % " &*():;{}[]/ \|

Please note that Energy Commission publications are in the public domain because they are
funded by public money. As such, photographs or other graphic files also are in the public
domain. The Energy Commission reserves the right to use PIER report photographs or other
graphic files in other publications or on the Energy Commission’s website.
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9.0 Use of the California Energy Commission Seal

PIER contractors should not use the California Energy Commission’s seal without permission.

The seal is used by the Energy Commission to indicate official information and / or official
Energy Commission publications. If it is used by other entities, it could be construed as an
endorsement of a product or process, and the Energy Commission and the State of California
cannot provide such endorsements.

Occasionally, the Energy Commission’s seal is used on banners or posters for workshops,
meetings, or conferences where the Energy Commission is a sponsor or co-sponsor. Or there may
be another reason for the Energy Commission seal to appear on PIER project-related items.
Those uses require approval by the Energy Commission’s Media and Public Communications
Office before the product is created.

If you have a question about the use of the Energy Commission seal, please contact the Media
Office at 916-654-4989.
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Please note that this page is normally left blank and is the back side of the final odd page of
Chapter 8. Usually no information is included on this page, nor is there text that says “this page
left intentionally blank.”
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